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1 Revision History

The revision history describes the changes that were implemented in the document. The changes are
listed by revision, starting with the most current publication.

1.1 Revision 6.0

The following is a summary of the changes made in this revision.

*  Updated the document for Libero SoC v2021.1.
. Removed the references to Libero version numbers.

1.2 Revision 5.0

Updated the document for Libero v11.7 software release (SAR 77926).

1.3 Revision 4.0

Updated the document for Libero v11.6 software release (SAR 72112).

1.4 Revision 3.1

Updated the document for Libero v11.5 software release (SAR 65408).

1.5 Revision 2.0

Added the bin2hex.exe file to the design files and added a link to design files in the Appendix 2: Creating
LookUpTable.Hex File, page 40 (SAR 63426).

1.6 Revision 1.0

The first publication of this document.
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Implementing Production Release Mode
Programming for SmartFusion2

2.1

2.2

2.3

Purpose

This application note demonstrates how to build single and multiple SoftConsole application executable
images in the production release mode, store them into embedded non-volatile memory (eNVM) using
eNVM data storage client, and execute them on SmartFusion®2 System-on-Chip (SoC) Field
Programmable Gate Array (FPGA) Security Evaluation Kit.

Introduction

SmartFusion2 devices have a maximum of two on-chip 256 KB flash memories called eNVM. The eNVM
is used to store the application code executable image or store data, which is used by the user
application. For more information about eNVM, refer to the eNVM chapter of the UG0331: SmartFusion2
Microcontroller Subsystem User Guide.

The user application projects are built in Release/Debug mode for execution on the SmartFusion2
Security Evaluation Kit through SoftConsole. In the Debug mode, the complete symbolic debug
information is emitted to the debugging applications, and the code is not optimized. In the Release mode,
the complete symbolic debug information is not emitted, and the code execution is optimized. The size of
the final release mode executable is smaller than the debug executable. It also runs faster than the
debug mode.

This application note describes the following:

*  How to build a single SoftConsole application executable image in production release mode, store
the image into eNVM using eNVM data storage client, and execute the image directly from eNVM of
the SmartFusion2 Security Evaluation Kit.

A sample SoftConsole application project fetches factorial of a number from a non-executable image
(LookUpTable.hex) stored in eNVM. LookUpTable . hex file contains pre-calculated factorial
values. For more information about how to create a LookUpTable. Hex file, refer to Appendix 2:
Creating LookUpTable.Hex File, page 40.

*  How to build multiple SoftConsole application executable images in production release mode and
store them into eNVM using eNVM data storage client.

The SoftConsole application projects show how the stored executable images in eNVM directly runs from
eNVM, and how to remap the images to run from eSRAM. The SoftConsole application projects
designed here are to blink LED on the SmartFusion2 Security Evaluation Kit.

To demonstrate the above two scenarios, two design folders with the SoftConsole application projects
are provided with this application note, refer to Appendix 2: Design Files, page 40.

References

The following list of references is used in this document:

*  UGO0331: SmartFusion2 Microcontroller Subsystem User Guide
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24 Design Requirements

Table 1 lists the hardware and software design requirements for running this demo design.

Table 1« Design Requirements

Requirement Version

Operating system 64 bit Windows 7 and 10
Hardware

SmartFusion2 Security Evaluation Kit: Rev D or later

* 12V adapter (provided along with the kit)
* FlashPro4 programmer
+ USB Ato Mini-B cable

Host PC or Laptop

Software
FlashPro Express Note: Refertothe readme. txt file provided in the
Libero® System-on-Chip (SoC) design files for the software versions used

with this reference design.
SoftConsole

Host PC Drivers (provided along with the design files) USB to UART drivers

One of the following serial terminal emulation programs: —
*  HyperTerminal

» TeraTerm

*+ PuTTY

Note: Libero SmartDesign and configuration screen shots shown in this guide are for illustration purpose only.
Open the Libero design to see the latest updates.

2.5 Prerequisites
Before you begin:

1. Download and install Libero SoC (as indicated in the website for this design) on the host PC from the
following location.

https.:.//www.microsemi.com/product-directory/design-resources/1750-libero-soc

2.  For demo design files download link:
http.//soc.microsemi.com/download/rsc/?f=m2s_ac426_df
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2.6 Building Executable Image in Release Mode

The following steps describe how to build an application executable image in the release mode:

1. Open the standalone SoftConsole IDE.

Figure 1+ SoftConsole IDE
SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsemi SofiConsole IDEvz4 s Lol )
Fic it Souce Ao Nevte s Prject o Windon i
[ &2 9L B S-F-CG- IR -8B IB-0-Q ™I ZR TR AT = ([Eger)
5 Project Explorer 23 = 0)([E) Welcome &3 =05 outi % Mak | = 8

= % 7|/ Microsemi SoftConsole IDE v3.4

) Additional Information

*Online documentation

=8
2. Right-click the Project Explorer window and choose Import, as shown in Figure 2.
Figure 2+ SoftConsole IDE - Import

€ /€= - Welcome to itasemi SoftConsole IDE V34 - Wicrosery SoRComABIEIDE T — T T — — oo
w5 9 s rgﬁgvﬁ?v@v;?v A - B - ;svoﬂgv LEASE H-f-eero- = ([Eger)
[ Project Explorer 57 = 0B Welcome 2 = O[3 outi 2 Mak | = 8

= % 7| Microsemi SoftConsole IDE v3.4 (rariesraaiiiz
20 Problems 52 Tasks | ] Console| I Propertes| =g
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3. Select General > Existing Projects into Workspace, as shown in Figure 3.
Figure 3+ SoftConsole IDE - Importing Existing Projects

SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsemi SoftConsole IDE v34

~ —~ — l=l®]| = J
e it o Source = Refactorss Navigatem Searcim Preectos Rurm Wi Help
=i 9 @O E G A B  H-0 A S B -eerD- & @)
25 Project Explorer 23 = 8)(B Welcome 2 =05 outi % Mak | = 8
= % 7| Microsemi SoftConsole IDE v3.4 [An outline s not avalable
SotConsol i  feesoftwaredevelopment envicnment
cnabimg the rapid procucion of C and C-+ ecutable fo procesors
valabi for et n Microsemi devces. Creatng 8 project insde SoftConsole
1o you writs software that i mmeciately compld nto 3 ssable it )
e you wrt et el compid v (oo —r
. Select \
5 Starta Project I
St POt ok ek Fle s News CPrajct Creste new prjects from an rchive il r diectory g
Give your prjecta name,and select a toelchan f1you are going to
e compiing ot 3 target othr shan the dfaul chaice of th Micresemi
Then chek Frish e
‘Add an initial source file with File > New > Source File type filter text
4 (= General
Add codetort, and clickthe Bd Allcon. e erie
|4 Bxisting Projects into Workspace |
~ ) File System
@ piningCote = prteancs
i can oo mport a eisting sourc e usin
Fles ,,,,Pm_p I I b C/Ces
and clck se o
General > Fe System & Rum/Debug
b & Team
) Additional Information
Relese Notes
~Oriine documentation
©) Bk Nets =
(2L Problems 57 Tesks| E Console| I Propertes| v=8
oitems
Description - Resource Path Location  Type
[nd 0 items selected
Import window is displayed, as shown in Figure 4.
Figure 4+ SoftConsole IDE - Browse
— —E————
56 /G - Welcome to iiasemi SoftConsole I0E V3 Nicroser SRESTABIRTOE vi 4 —— o8] x|
e it o Source = Refactorss Navigatem Searcim Preectes Rurm Windowss Help
- 9L BB B -G R -Bi B0 -Qi®P B L = [@oes)
25 Project Explorer 23 = 8)(B Welcome 2 =05 outi % Mak | = 8
= % 7| Microsemi SoftConsole IDE v3.4 [An outline s not avalable
SotConsol i  feesoftwaredevelopment envicnment

enabling the rapid production of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SoftConsole:
lets you write software that is immediately compiled into a usable binary.

¢ Import [
~ Import Projects.
5 Starta Project

St POt ok ek Fle s News CPrajct Select a diectory tosearch for sisting Eclpse prcject,

Give your project a name, and select a toolchain f you are going to <

be compiling for a target other than the default choice of the Microsemi
“Then click Finish.

Select root directory: Browse.

(© Select archive file

Addan il sourc e with Fle > New > Source Fle
Addcode o, and clckthe Buid Al icon -
- Select All
% Ve con oo mportn g srce e uing
e Import

and

o

) Additional Information
* Release Notes

* Online documentation (] Copy projects into workspace

Working sets
7)Add project to working sets

Warking sets Select.

® b [

20 Problems 52 Tasks | ] Console| I Propertes| =g
0items
Descrption B Resource Path Location Type

o 0 items selected

Microsemi Proprietary AC426 Revision 6.0



Implementing Production Release Mode Programming for SmartFusion2

& Microsemi

a AS\MicrocHip company

Figure 5+ SoftConsole IDE - Browsing for Projects Folder

actor Navigate

un Window Help

mhe A E S @G RS B0 @ & B v Fl v ey & @)
25 Project Explorer 23 = 8)(B Welcome 2 =05 outi % Mak | = 8
= % 7| Microsemi SoftConsole IDE v3.4 [An outline s not avalable
SoftConsole s afree software development environment

enabling the rapid production of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SoftConsole:
lets you write software that is immediately compiled into a usable binary.

e Import [

. Import Projects
) Starta Project

To begin your work, click File > New > C Project

Give your project a name, and select a toolchain if you are going to

be compiling for a target other than the default choice of the Microsemi |
“Then click Finish.

Select a directory to search for edsting Eclipse projects

2 =
-
Select oot directory

© Select archive file

‘Add an initialsource file with File > New > Source File

Browse.
Add code o, and click the Bild Al con. e )
Select root decory of the projecs o mport
5 Existing Code
Vou can also import an exstng source tre using
File > Import.. 2L Local Disk (©) B
General > Fle System > 0 pen
o 0b dir
4 1L eNVM_DataClient
5 AdditonslInformation > B component
* Reease Notes L
> UL constrint =
« Online documentation @ Coy prof| > Ul designer
e > Ul firmware
i hal
(] Add proj | .
Working sd B smartgen
4 softConsole
4 1L eNVM_DataClient Mss_CM3
| projects|
> Ul metadata
@ > L eNVM_DataClient MSS_CM3_app
> 1 eNVM_DataClient_ MSS_CME_hw_pltform
I stimulus
> UL synthesis
(2L Problems 57 Tesks| E Console| I Propertes| — tooldata = v=8
« 0 3
0jtems
Description B

Resource Path | Foders  projects

o 0 items selected

Microsemi Proprietary AC426 Revision 6.0



Implementing Production Release Mode Programming for SmartFusion2 O M. em’.

a AS\MicrocHip company

4. Ensure that Copy projects into workspace check box is checked, as shown in Figure 6. Click
Finish.

Figure 6 = SoftConsole IDE - Creating Work Space in App Folder
['se impor )

Import Projects

Select a directory to search for existing Eclipse projects.

| X

@) Select root directory:  CheNVM_DataClient\SoftConsoleleNVM_Datat

() Select archive file: Browse...
Projects:

eMVM_DataClient_MS5_CM3_app (C:heNVM_DataClient\SoftCons Select All

eMNVM_DataClient_MS5_CM3_hw_platform (CheNVM_DataClient.!
Deselect All

4 1 ] +

Copy projects into workspace
Working sets
[] Add project to working sets

Working sets: Select...

@ ned> | [ Finish ][ Cancel

h

The SoftConsole perspective is shown in Figure 7.

Figure 7« SoftConsole Workspace
SE C/Ce+ - eNVM_DtaCHERENES B sppimaine T Wiarsent SoTCaa BEvaA TR T R || )

Ele Edit Source Refactor Navigate Search Project Run Window Help

H-Held 9is i @-8-@-0- &8 i$-0-Q%-®s BED Y- -vera- = [Eoc]
5 Project Explorer 23 B % © = O|(E maine 3 =05 outi % Mak | = 8
15 eNVM_DataClient_MSS_CM3_app. 7 . B o %7
) Includes “oint main() o misoh
[g] main.c ff( ® drivers/mss_uart/mss_ui
2 eNVM _DataClient MSS_CM3_hw _platform 0 uinté_t rx buff[l]; # ENVMLDEMOIMAGE S
unsigned long daca; eI Ao
e o printnumber(int) s int
e el cnponence - o UART Polled o(mss_uz
74 ) BAUD,MSS_UART DATA 8 BITS | MSS_UART NO_PARITY | MSS_UART ONE_STOP BIT ): © main:int
75 “)7$455 Walooms to SmartFusionz $FHH\T\I7,sizeof ("$#Hf Welcoms to SmartFusionz HE\Z\ZT)):
76
7 while (1)
¢
MSS_UART_polled tx(&g_mss_uartl, s Please Select the Following option\n\r",sizeof ("Please Select the Following optiom\n\z")); M
MSS_UART polled _tx(&g_mss_uartl, ] n\z", sizeof ("1.Factorial of 2\n\z")) £
MSS_UART polled _tx(&g_mss_uartl, ", sizeof ("2.Factorial of 3\n\z")): i
155 UART polled tx(cg mss warti, " sizeof (3. Factorial of \m\z")):
while( (!(UART_Polled Rx ( &g_mss uartl, rx_buff, 1))) )
Gata = *(unsigned int «)ENVM_DEMO_IMAGE_STORED ADDR:
byce[s] = data & OxFE; /* 0 =7 * u
T . T » « [0 »
(2L Problems [ Tasks [l Console £ . [ Propertes| @& BE-9-=0

C-Build [eNVM_DataClient_MSS_CM3_app]

Wiitable Smartlnsert | 74:41
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5. Right-click both the project names in the Project Explorer view and select
Build Configurations > Set Active > Release, as shown in Figure 8.

Figure 8 « Building Configurations

SC C/C+ - eNVM_DataClient MS5.CM3_app/main.c - Nicrasermi 3 =l x|

File Edt Source Refactor Navigate Search pmm Run Window Help
=4 |Bi9is @ -8 E-G- K-8 $-0 Q- &~ o H-F-eara- = Eoc]

[ Project Explorer 23 B % ~ = 0B minc 2 =0z oui X @mak | = O
» (IS eNVM_DataClie ’ o BV o %7
» [i25 eNVM_DataClie nt main() U masoh

New vk
R i 2 drivers/mss_uart/mss_u
Golnto ety # ENVM_DEMO_IMAGE.S
& Copy CtrieC unsigned int byte[4]; © printnumber(n): nt
e . /* Initialization all necessary hardware components */ ©  UART.Polled Rxfmss_ua
MSS_UART_init( &g_mss_uartl,MSS_UART_57600_BAUD,MSS_UART DATA & BITS | MSS_UART_NO_PARITY | MSS_UART ONE_STOP_BIT ); © main0:int
X Delete Bz MSS_UART_polled_tx(&g_mss_uartl, (uint8_t *)"#### Welcome to SmartFusion2 ####\n\r", sizeof ("#### Welcome to SmartFusion2 ####\n\x"));
Move.
Rename. 3 while (1)
t
g Import. MSS_UART polled tx (&g_mss_uartl, (uints t *)"Please Select the Following option\n\r",sizeof ("Please Select the Following optiom\m\z"));
) | e MSS_UART polled tx (&g_mss_uartl, (uinté_t *)"1.Factorial of 2\n\r",sizeof ("1.Factorial of 2\m\z")
MSS_UART polled _tx(&g_mss_uartl, (uinté_t *)"2.Factorial of 3\n\z",sizeof("2.Factorial of 3\n\z")
Build Project MSS_UART_polled_tx (2g_mss_uartl, (uints_t %)"3.Factorial of 4\n\r",sizeof ("3.Factorial of 4\n\r")
Clean Project
while( (! (UART_Polled Rx ( &g_mss_uartl, rx buff, 1))) )
&) Refresh 5 ; - = e =
Close Project
Close Unrelted Projects Gata = *(unsigned int «)ENVM_DEMO_IMAGE_STORED ADDR:
Exclude from build byce[s] = data & OxFE: /* O u
Build Configurations. »[ sethcive [ 1pebug | , m v
Make Targets | i » | V] 2Relense | BBl B -0
Index »|  Delete resource cfgs. T
ConvertTo, Manage. | 3
Release for project eNVM DacaClient MSS_CH3_app *+++
Run As , o 983
Debug As > |clean
Profle As ) 1 ./eNVM DataClient MSS_CM3_app.map
T L0 y-map /main.o  ./main.d eNVM DataClient MSS_CM3_app.srec eNVM DataClient MSS_CM3_app.hex eNVM DataClient MSS_CM3 app.lst eNVM DataClient MSS_CM3_app
DecaClient 1SS CM3_app
Compare With , S
Restore from Local History.

o 5 2 items selected

6. Go to Project > Build All and build the project, as shown in Figure 9.
.hex file is generated in the Release folder (refer to Figure 10, page 9 and Figure 11, page 9).

Figure 9 «  Build All
5¢ C/cr+ - NV DRGNS OV e Ve S B T T — o O )

File Edit Source Refactor Navigate Search [Project] Run Window Help

w5 |G 9 ia ig@-e| OpenProjet Qi g R = [Eoes)
Close Project
[ BrojectExplorerii J = 1[5 outh 2 Mak | = B
25 eNVM_DataClient MSS_CM3_app| o Build All Curl+B / 2 BR o %7
» [125 eNVM_DataClient_MSS_CM3_hw_platform| Build ofi ti » RO  m2sooch
Build Project U drivrs/mes_usrt/mss
ot rx pusz(il; uan/mes
Build Working Set 1 Pt # ENVMLDEMOIMAGE.S
o printnumber(int): int
Clean e int byte(4]
o veets] o UART_Polled_Re(mss_us
N

fnitialization all necessary hardware components */

— UART init( &g_mss_uarti,SS_UART_57600_BAUD,MSS_UART_DATA 8 BITS | MSS_UART_NO_PARITY | MSS_UART_ONE_STOP_BIT ); main):int
Meake Target » [0ART polled tx (sq_mss_uarci, (uints_t *)"#### Welcome to SmartFusion2 $F##\n\r",sizeof ("###} Welcome o SmartFusion2 ##H\nm\z")):
Properties e (1)
T

MSS5_UART polled_tx(6g_mss_uartl, (uinté_t *)"Please Select the Following optiom\n\r",sizeof ("Please Select the Following optiom\m\z")); M

MSS_UART polled_tx (&g_mss_uartl, (uints_t *)"1.Factorial of 2\n\r",sizeof("1.Factorial of 2\nm\z")):

MSS_UART polled_tx(6g_mss_uartl, (uinté_t *)"2.Factorial of 3\n\z",sizeof("2.Factorial of 3\m\z")

MSS_UART polled_tx (&g_mss_uartl, (uints_t *)"3.Factorial of 4\m\r",sizeof("3.Factorial of 4\m\z")):

while( (:(VART_Polled Rx ( &g_mss_uartl, rx buff, 1))) )

data = *(unsigned int *)ENVM_DEMO_IMAGE_STORED_ADDR;

byce(3) = data & OXFE; /* 0

F < ’

[ Problens [ Toss| & Console 55 Propenis]
C uild [NVMLDsaChent S5 M o

%% Clean-only build of configuration Release for project eNVM DataClient MSS_CH3_app *++*

make clean
m -rf ./eNVM DataClient MSS_CM3_app.map
m -rf memory-map.xml ./main.o ./main.d eNVM DataClient MSS_CM3_app.srec eNVM DataClient MSS_CM3_app.hex eNVM DacaClient MSS_CM3 app.lst eNVM DataClient MSS_CM3_app

eNVM_DataClient MSS_CM3_app

o 5 2 items selected

Microsemi Proprietary AC426 Revision 6.0 8
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Figure 10 + Generating Hex File

SC C/C++ - eNVM _DataClient MSS_CM3_app/main. - Microsemi e oo D )

File Edt Source Refactor Navigate Search Project Run Window Help

ERAFRETE-NE B SR R R R I S ) I A I R I S = @)

5 Project Explorer 23 % ~ = 0|([@ mainc 2 =05 outi % Mak | = 8
12 eNVM DataClient MSS_CM3_app 67/ 9 A SR
25 eNVM_DataClient_MSS_CM3_hw_pltform 621int main() o misoh

s . ettiin 2 drivers/ms_uart/mss._ui
pintt v zx barflils # ENVM_DEMO_IMAGE.S

71 unsigned long data: N

72 unsigned int bycel4]: ° P

73 /+ Initialization all necessary hardware componenta */ © UART Polled Re(mss_ua

7¢  MSS_UART init( &g_mss_uarcl,MSS_UART_57600_BAUD,MSS_UART DATA & BITS | MSS_UART_NO_PARITY | MSS_URRT_ONE_STOP_BIT ); © maing:int

75 MSS_UART polled tx(ag_mss_uarcl, (uinté_c *)"#### Welcome to SmarcFusion2 $7##\n\r", sizeof ("$### Welcome To SmarcFusion2 HHHH\m\z®));

76

77 while(n)

7t

MSS_UART_polled tx (£g_mss_uarti, (sints_t =)"Please Select the Following option\m\r",sizeof ("Please Select the Following option\n\z"));
MSS_UART_polled tx (2g_mss_uarti, (wints_t %)"1.Factorial of 2\n\r",sizeof ("1.Factorial of 2\n\z"));
MSS_UART_polled_tx (2g_mss_uarci, (wints_t %)"2.Factorial of 3\n\r",sizeof ("2.Factorial of 3\n\z"));
MSS_UART_polled tx (2g_mss_uarti, (wints_t %)"3.Factorial of 4\n\r",sizeof ("3.Factorial of 4\n\z"));

while( (:(VART_Polled Rx ( &g_mss_uartl, rx buff, 1))) )

data = *(unsigned int *)ENVM_DEMO_IMAGE_STORED_ADDR;

bycels u
. i e - ) , .
[E! Problems [ Tasks 5 Propertis | @ fE-5-—0
C-Build [eNVM_DataClient_MSS_CM3_app]
Ee LG\ e 5 S5 CH3\eNVH_ | - ¥S5_C3 B g A
../ /e s . MSS_Cu3_ta_pl. _ ace.1d -il,-Hap=eNVii_DacaClient 4SS_Qi3_app.map -Xlinke: -go-sections
oreNvM DataClient MSS_CM3_app" ./main.o C:/eNVM{ {1 . MSS_CH3/eNVH I M55 CH3_t_pl. p_ b m2exx.o
C: /e {1 155 Ci3/eNVM_DataClient ¥sS _C¥s tw pl 5 . Stubs.o ~1eNVM DataClient M Cs_nw placform
\Finished building cazgec: eNVH DataClient }SS S app’
Invoking: Memory map generator’
actel-map o " Lt eV I . usS_cus_app e .specs
N I {1 HMSS_CH3\eNVH I - MSS_CH3 1 3 "
e . MSS_CH3_h_pl. o ace.1d -il,-Hap=eNV_DataClient }SS_Ci3_app.map -Xlinker -go-sections

ted file memory-map.xml
'Finished building: memory-map.xml'

'Invoking: GNU Intel Hex File Generator'
arm-none-eabi-objcopy -O inex eNVM DataClient MSS_CM3_app "eNVM DacaClienc MSS_CM3_app.nex"
'Finished building: eNVM DacaClient MSS_CM3_app.hex’

| Invoking: GNU S-Record Generator®
arm-none-sabi-objcopy -0 srec SV DacaClient sk CUS_app "eMV DataClient MSS_CH3_app.srec
Fintshed building: SNV DacaClient MSS_CH3 app.szect

'Invoking: GNU Listing Generator'
Jdump -h -S eNVM_I . 1SS_CM3_app > "eNVM_DataClient MSS_CM3_app.lst”
'Finished building: eNVM DacaClient MSS_CM3_app.lst’

0

Figure 11 » Hex File in Release Folder

| =

@@' j'l C:\eMVIM_DataClient\SoftConsole'eNVIM_DataClient_M55_CM3'\projects\eNVM_DataClient_MS5_CM3_app'\Release ¥ | +¢ || Seorch Release pel

Organize v Include in library + Share with + Burn MNew folder ~ [ @
¥ Favorites * Name . Date modified Type Size
B Desktop | eNVM_DataClient_MS5_CM3_app 2/9/2015 11:47 AM File 128 KB
& Downloads =] eNVM_DataClient_MS5_CM3_app 2/9/201511:47 AM  HEX File 13 KE
(i-"‘j. Recent Places | eNVM_DataClient_MS5_CM3_app.lst 2/9/2015 11:47 AM LST File 106 KB
| eNVM_DataClient_MS5_CM3_app.map 2/9/201511:47 AM  MAP File 54 KB
il Libraries = | eNVM_DataClient_MSS_CM3_app.srec 2/9/2015 11:47 AM SREC File 13KB
@ Documents | main.d 2/9/201511:47 AM D File 1KE
J’ Music L] main.o 2/9/201511:47 AM O File 3KB
[ Pictures | makefile 2/9/201511:47 AM  File 3KB
B8 videos =] memory-map 2/9/201511:47 AM XML Document 1KB
' || objects.mk 2/9/201511:39 AM - MKFile 1KB
8 Computer | sources.mk 2/9/2015 11:47 AM ME File 2KB
ﬁ Local Disk (C:) | subdir.mk 2/9/2015 11:47 AM ME File 3KB
—a New Volume (D:) ~
] 12 items
= = =
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2.7 Loading the Executable Image into eNVM

The following steps describe how to load the generated executable image into eNVM of the
SmartFusion2 device using the System Builder eNVM Configurator:

1.  Open the Libero SoC hardware project eNVM_DataClient_top tab, refer to Figure 12.
Figure 12 + eNVM_DataClient_top Tab

Project File Edit View Design Tools SmartDesign Help

DEea2X0

Design Flow & x | B envM DataClient_top™ & X | Reports @ X | StartPage @ X | v
= D —p D gD & ‘
eNVM_DataClient_top RN MH 2550 o0 B0 @ & S AaNDO
Tool - -
¥ 4 ) Create Design
& System Builder E
"4 & Configure MSS
B2 Create SmartDesign L
Create HDL eNVM_DataClient_0 3
P 4 FAE_RESET_N POWER_ON_RESET N[ X
4 Create SmartDesign Testbench DWEU‘ e R
Create HDL Testbench i S5 READY B X
4 b Verify Pre-Synthesized Design ST R . R R P
B simulate 7AGOOC PNSH ’X
4} Create Constraints i FAB_GCC_ 00K ;x
= INIT_PINS
IO Constraints o -
4 {9 Timing Constraints 2
@) synthesis\eNVM_DataClient_top_sde.sdc
B Floerplan Constraints
i 4 b Desion o -
Design Flow | Design Hierarchy |  Stmulus Hierarchy | Catalog | Fies | |L° n '
B x

Log

@ Erors i, Wamings i Info

Project closed.
The 'close_project’ command succesded.
The Execute Script command succeeded.
Info: 'eNVM DataClient top' was successfully generated.
@1nzo: env DateClient_top' manifest file 'C:/eNV DataClient/component/work/elVM DataClient_top/eNVM DataClient_top manifest.txt’ was successfully generated. N

log | Message
Fam: SmartFusion2 | Die: M25090T |Pkg: 484FBGA |Verilog

2. Double-click eNVM_DataClient_0 and go to System Builder - Memories page to add the eNVM
Data Storage client, refer to Figure 12.

3. Select Data Storage under the Available Client Types tab and click Add to System..., refer to
Figure 13. This opens the Add to Data Storage Client window, as shown in Figure 14.

Microsemi Proprietary AC426 Revision 6.0 10
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'@ System Builder - Memories —— -_— T R — — M‘
> Device Features » y Memories » » Peripherals » » Clocks __» » Microcontroller »  SECDED _» » Security » » Interrupts » » Memory Map »
Configure your external and embedded memories

MDDR )/ ENVM
Avaizble Clent types User Clients in eNVM
Data Storage
Serialization Chent Type Client Name: DepthxWidth Start Address(Hex) Page Start Page End | Initialization Order ] Lock Start £
Add to System
Usage Statistics
Available Pages: 2032
Used Pages: 0
Free Pages: 2032
< m 13
(e ]

L

Figure 14 » Add Data Storage Client Window

| Add Data Storage Client

Client name:
elVM
Content:

@ Memory file:

Format: | Intel-Hex A

[ Use absolute addressing o

(©) Content filed with 0s

() No Content (Client is a placeholder)

Start address: 0x 0 =

Size of word: bits

Mumber of Words: 1 (dedimal)

|:| Use as ROM o

[ Use Content for Simulation

i
[l Ok ] [ Cancel
L——-‘-—A_—- I — p———— —_— —— Y |

Microsemi Proprietary AC426 Revision 6.0
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4. Enter a data storage client name in the Add to Data Storage Client window.

Figure 15 + Add Data Storage Client Window
“—-w*

f —
(® Modify Data Storage Client

Client name:  Main_App|
elVM

@ Content from file:  |M55_CM3_app/Release/eNVM_DataClient_MS5_CM3_app.hex E]

[ Use absolute addressing o
l (©) Content filed with 0s

() Mo content (dient is a placeholder and will not be programmed)

Start address: 0x 0 E

Size of word: Bits

Mumber of words: 4592 Decimal

|:| Use as ROM o

[ Use content for simulation

Help I OK I[ Cancel ]

b

5. Browse for the .hex file generated in the SoftConsole project after building an executable image in

the Release Mode. The generated executable image is in the Release folder under the SoftConsole
project workspace, refer to Figure 16 and Figure 17, page 13.

Figure 16 » Executable Image in Release Folder

m‘ ISQIC:\eNVIM_DataClient\SoftConsoleleNVh_DataClient_MSS_CM3\projects\eMVM_DataClient_MSS_CM3_app\Release]
Organize = Include in library = Share with = Burn Mew folder
Y Favorites * MName : Date modified Type Size
B Desktop || eMVM_DataClient_MSS_CM3_spp 30-09-201511:38 File 128 KB
& Downloads || eMVM_DataClient_MSS_CM3_app.hex 30-09-201511:38 HEX File 13 KB
“El Recent Places | eNVM_DataClient_MS5_CM3_app.lst 30-09-201511:38 LST File 106 KB
| eMVM_DataClient_MS5_CM3_app.map 30-09-201511:38 MAP File 54 KB
o Libraries £ | eNVM_DataClient_MS5_CM3_app.srec 30-09-201511:38 SREC File 13 KB
%] Documents || maind 30-09-201511:38 D File 1KB
& Music | main.o 30-09-201511:38 O File 3KB
[ Pictures | makefile 30-09-201511:38 File 3KB
Subversion = memory-map 30-09-201511:38 XML Document 1KB
B8 videos — || objects.mk 30-09-201511:38 MK File 1KB
| | sources.mk 30-09-201511:38 ME File 2KB
18 Computer | subdir.mk 30-09-201511:38 MK File 3KB
£, Local Disk ()
' 12 tems
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Figure 17 « Add Data Storage Client Window

. ___ \
@ Mot D |

Client name:  Main_App|
eNVM

@ Content from file:  |M55_CM3_app/Release/eNVM_DataClient_MS5_CM3_app.hex E]

Format: | Intel-Hex A

[ Use absolute addressing o
() Content filed with 0s

(7 Mo content (dient is a placeholder and will not be programmed)

Start address: ox 0 =

Size of word: Bits

Mumber of words: 4592 Decimal

|:| Use as ROM o

[ Use content for simulation

Help [ OK ][ Cancel ]

6. Click Ok in the Add Data Storage Client window.
7. Add LookUpTable.hex file to eNVM Data Storage Client, as shown in Figure 18, page 14 and
Figure 19, page 14.
Note: The LookUpTable.hex file contains the pre-calculated data of the factorial of numbers 2, 3, and 4 (2, 6,
and 24 in Hexa decimal format). This is a non-executable image and is stored in eNVM. The factorial
data is fetched by the main application.

Microsemi Proprietary AC426 Revision 6.0 13
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Figure 18 »

(€I

ANEC:eNVIM_DataClient\SoftConsele\eNVM_DataClient_MSS_

LookUpTable.hex File

& Microsemi
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7l Libraries
@ Documents
J}‘ Music
[ Pictures
Subversion

i Videos
1% Computer
&L, Local Disk (C3)

—a Mew Volume (D:)

“- Metwork

', 4 items

Organize = Include in library = Share with = Burn Mew folder = [ @
Y% Favorites Narme ° Date modified Type Size
Bl Desktop | .metadata 30-09-201511:37 File folder
& Downloads 1 eNVM_DataClient_MSS_CM3_app 30-09-201511:37 File folder
f_:‘l Recent Places 10 eMVM_DataClient_MS5_CM3_hw_platform  30-09-201511:37 File folder
| LockUpTablehex 18-06-2014 11:40 HEX File 1KB

8. Select Start address as 20000 in the Add Data Storage Client window, refer to Figure 19. This is the
address in eNVM, where the LookUpTable.hex file is stored. Click Ok.

Figure 19 » Add Data Storage Client Window

r 7 Storooe Gt ———— ) [ ]
(® Add Data Storage Client (9 ]

Client name: LookUp_Table
elVM
Content:

@ Memory file: |-lVM_DataCIient_MSS_CM3,."pr0jectsﬂ_ookUpTabIe.hex| [

[ Use absolute addressing o

(©) Content filed with 0s

() No Content (Client is a placeholder)

Start address: Ox Zm
Size of word: bits
Mumber of Words: 4 (decimal)
|:| Use as ROM o
[ Use Content for Simulation
| Help Ck I [ Cancel

Microsemi Proprietary AC426 Revision 6.0
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9. Inthe System Builder - Memories page, keep the other settings to default and click Next, refer to
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Figure 20.
Figure 20 » System Builders - Memories Page
—_— =SS S e T W — v
( System Builder - Memories SR
> Device Features Memories » > Peripherals » ; Clocks Microcontroller > > SECDED ; ? Security Interrupts » > Memory Map »
Configure your external and embedded memories
MDOR. EMNVM
Avalizble Cent types User Clients in eNVM T
Data Storage
Serialization Client Type Client Name DepthxWidth Start Address(Hex) Page Start Page End Initialization Order
1 |{@ patastorage| Main_App 4592x 8 0 0 35 NfA
—— 2 (@ DataStorage look 4x8 20000 1024 1024 NJA
| add to system...
Usage Statistics
Available Pages:4032
Used Pages: 37 E
Free Pages: 3995
< n 3
B Used Space R
Bl FreeSpace Edt || Delete |
S i
o

10. Save eNVM_DataClient_top and regenerate the eNVM_DataClient_top component by clicking
Generate Component in SmartDesign.

11. Click Generate Bitstream to complete the remaining steps to generate fdb file (synthesis, place-

and-route).
12. Click Run PROGRAM Action to program the SmartFusion2 Security Evaluation Kit, refer to

Figure 21, page 16 and Figure 22, page 16.

Microsemi Proprietary AC426 Revision 6.0
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Figure 21 » Selecting Run PROGRAM Action

) Libero - EANVM,_DatadiientieNVM DataClient.pr R S S

Project File Edit View Design Tools Help

=
DEwaNo0a
Jesign Flow

eNVM_DataClient_top

=2 O

Teol

@, Verify Timing

@, Open SmartTime

[ Verify Power
4 b 10 Analyzer

5 10 Advisor
%5 SSN Analyzer
Program and Debug Design
+L] Generate FPGA Array Data
[ Update eNVM Memory Content
4 ) Configure Hardware
PI Programming Connectivity and Interface
& Configure Programmer
[} Devieel/O States During Programming
Configure Security and Pragramming Options
« Configure User Programming Data

@ Configure Programming Recovery
@ Configure Security
Program Design
% Generste Bitstream
‘& Run PROGRAM Action
4 b Dehug Desian

.

v

DesignFlow | DesignHerarchy | Catelog | Fies |
w09
[[E]vessage: | €@ Errors i, Warmings ) 1nfo

Software Version: 11.7.0.119
Software Version: 11.7.0.11%

Generating Bitstream File

Softvare Version: 11.7.0.119
Software Version: 11.7.0.11%
Softvare Version: 11.7.0.119

& Microsemi

a AS\MicrocHip company

Reports @ X

Startpage @ x| 2] enviv_DataCient top & X

€NVM_DataClient_top_joffaml
€NVM_DataClient
€NVM_DataClient €CC_0_co.
€NVM_DataClient SYS_BLD.x.
€NVM_DataClient_manifestit
NV _DataClient MSS

N

N

€NVM_DataClient_MSS_mani
4 /i Generate Memory Map
€NVM_DataClient_top_DataS.
Synthesize
synplifylog
i eNVM_DataClient top.sr
run_options txt
Compile
€NVM_DataClient_top_comp.
€NVM_DataClient top_comp.
€NVM_DataClient top_comb.

N

N

N
Fl
2

€NVM_DataClient_top_glb_n.
@ envM_DataClient_top_a.
Generate FRGA Array Data
€NVM_DataClient top_init.c..
Generate Bitstream

N

N

<

@ 0Evors i, OWarnings i 0Info

€NVM_DataClient MSS_DRC.... _

Software Version: 11.7.0.119

Opened 'C: /elVM_DataClicat { DetaClicnt_top/clVM I ._top_fp/elVM DataClient_top.pra’
The "open_project’ command succesded.

PDB file 'Ci\eNVM

S pdo' has been loaded successfully.
DESIGN : eNVM_DataClient_top; CHECKSIM
The "load programming data' command succeeded.
The "set_programming_file' command succesded.
Project saved.

The "save_project’ command succesded.
Ezoject closed.

NVM DataClient top_genero:

Opened 'C:/elVM_DataClient/designer/eNVM DataClient_top/eNVM DataClient_top_fp/elVM DataClient top.pro”

The 'open project' command succeeded.

EDB file 'C:\elVM DataClient\designer\eNVM _DataClient_top\f&30dcie-fb85-4e67-bbB5-3e6Efba53e6s.pdb" has been loaded successfully.

The 'set_programming file' command succeeded.
Project saved.

The 'save_project' command succeeded.
Project closed.

The 'close_project' command succeeded.

The Execute Scrips command succeeded.

Generating Bitstream File Finished :

Cleaning tool 'Run pregramming actions'...

BDE_VERSION :

Mon Mar 14 11:07:50 2016 (Elapsed sime

1.9

00:00:55)

Deleting 'C:\eNVM DataClient\designer\eNVM _DataClient_top\eNVM_DataClient_top_fp\eNVM DataClient_top FROGRAM.log'

Log | Message

Figure 22 »

Programming SmartFusion2 Security Evaluation Kit

(@ Libero - C:\eNVM_DataClient\eNVM_DataClient prjx - - - — ~— T— —
Project File Edit View Design Tools Help

~

NS0 o
Design Flow 8% Reports @ x

eNVM_DataClent_top

Startpoge 8 X | B2 &NV _DataCient top & X

eNVM_DataClient_top_ioffam| =

[ETR) @ osrors 4 oviemings @010

4 eNVM DataClient
Tool B eNVM DataClient CCC 0 co.. || Software Version: 11.7.0.113
&, Verity Timing €NVM_DataClient_SVS_BLD.x. Opened *C:/eNVM_DataClient/designer/eNVH_DataClient_top/elVi_DataClient_top_fp/elVM_DataClient_top.pro’
&, open smart? eNVM_DataClient_manifesttt || The 'open_project’ command succeeded.
pen SmartTime 4 eNVM_DataClient MSS DB file 'C:\ellV¥Y_DataClient\des { DataClient_top\f: -bbE5-3e617b53e6. pab’ has been loaded successfully.
I Verify Power ' i DESIGN : NV DataClient_top; AEBF; PDB_VERSION : 1.9
eNVM_DataClient MSS_DRC..
4 b 10 Analyzer VM Dot WSS The 'load_programming_data’ command succeeded.
& 10 Advisor Vvl Datatlient Vs mani The 'set_programming_file' command succeeded.
5 h 4 /i Generate Memory Map Eroject saved.
£ SN Analyzer :
PR d Debug Desig eNVM_DataClient_top DataS... | || The 'save_project’ command succesded.
rogram and Debug Design 4 Synthesize Eroject closed.
v +{] Generate FPGA Aray Data synplityJog
[ Update eNVM Memory Content i . eNVM_DstaClient_toparr
. ure Hardware run_options bt
Bl Programming Connectivity and Interface 4 Compile
& Configure Programmer eNVM_DataClient top_comp... |~
B8\ Device /O States During Programming NVM_DataClisnt_top_comp... |
4 > Configure Security and Programming Options eNVM_DataClient _top_comb.
# Configure User Programming Data @ =NVM_DataClient top_c.
& Configure Programming Recovery 4 Place and Route
@ Configure Security NVIM_DataClient_top_glb.n. (= )
4 ) Program Design @ enviv DataClient top._la.
v % Generate Bitstream 4 Generate FPGA Array Data Running PROGRAM Action. Please do not interrupt,
o & Run PROGRAM Action eNVM_DataClient top_init_c.
4 b DebuaDesion z 4 Generate Bitstream
eNVM_DataClient top_gener.. ~
| oesgnrion | [ catmeg [ Fis |
Log

Qe

Software Version: 11.7.0.118

i, Warnings

@ rfo

Opened 'C:/eliV¥_DataClient/designer/eNVi_DataClient_top/eV¥_DataClient_top_fp/eNVM DataClient_top.pro’
"

The 'epen project! command succesded.

PDB file 'C:\eNVM DataClient\designer\eNvM_DataClient_top\f830dc8e-fbsS-4e6f-bbS-3e6Eb853e6.pdb’ has been loaded successfully.

DESIGN : eNVM DataClient_top; CHECKSUM : AEBE;
The 'load _programing_data’ command succeeded.
The 'set_programming file' command succeeded.
Project saved.

The 'save project! command succesded.

Project closed.

The 'close project’ command succeeded.

The Execute Script command succeeded.

BDB_VERSION

119

Generating Bitstream File Finished : Mon Mar 14 11:07:50 2016 (Elapsed time 00:00:55)

Cleaning tool 'Run programming actions...
Deleting 'C:\eNVM DataCl

Software Version: 11.7.0.118
Software Version: 11.7.0.118
Driver : 3.0.0 build 1
programmer '92601' : FlashPro4
Rescanning for Programers
programmer '92601' : FlashPro4

\elVM_DataClient_top\eNVM DataClient_top_fp\eNVM DataClient_top FROGRAM.log'

Log [ Message
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Updating eNVM Memory Content

This option is available in Libero design flow to load the updated . hex files after compiling the
application code in SoftConsole. Without this option, every time the SoftConsole application is built,
System Builder eNVM Configurator is required for updating the eNVM client with the new . hex file
generated, which is time consuming.

If the new . hex file generated from the SoftConsole application project is larger than the previous .hex

file, Update eNVM Memory Content throws an error. Go back to the System Builder and manually
update the Hex file.

The following steps describe how to use the Update eNVM Memory Content option:

1. Choose Update eNVM Memory Content option from Libero design flow.

Figure 23 + Choosing Update eNVM Memory Content Option from Libero Design Flow

i
(@ Libero - CAeNVM _DataClient\eNVM_DataClient prix® SSSG_—_--—e—— e " m——————————————————— BT

Project File Edit View Design Tools SmartDesign Help

OEw 22X 0

= 8 %[ Reports & x ‘ B envM_Dataclient_top & X ‘ StartPage B X | 5

BERI e ME RSP0 O OO EE ANDO
Tool - I
[ Verify Power
& 10 Adviser
4 b Edit Design Hardware Configuration
I Programming Connectivity and Interface
& Programmer Settings
5 Device /0 States During Programming eNVN_DataClient_0
4} Configure Security and Programming Options 4 FRE_RESET N FOWER_ON_RESET_NPX
) Configure User Programming Data DEVRSTN TEED | 4
BB Configure Programming Recovery MUART_i FADSEQ W
@ Configure Security T
BB Update eNVIM Memory Content
¥ 4 » Program Design
BB Configure Bitstream
v B2 Generate Bitstream
"4 BB Run PROGRAM Action
4 b Debug Design
£, Identify Debug Design - il

&NVM_DataClient_top

m

n

Design Flow | Design Hierarchy | Stmulus Hierarchy | Catalog | Fies | L )

Log 8 x

[E]essages | @ errors i, Warnings i Info

programmer ' : device i
| programmer ' : device 'M25030T" : EXPORT VEE: [8

programmer ' : device 'M2S090T' : Programming FPGA Array and elVM...

programmer ' : device 'M25030T" :

programmer ' : device 'M2S090T' : EXPCRT DSN[128] = 590££38e5I7d56fb7aaboT5149ca32z0

programmer ' : device 'M25030T" :

programmer ' : device 'M2S090T' : Finished: Mon Feb 09 12:37:24 2015 (Elapsed time 00:01:42) 3

programmer ' : device 'M25030T' : Executing action FROGRAM FASSED. m

nraarammer 1 + Chain nrosrawming PLSSED

log | Message

Fam: SmartFusion2 | Die: M25030T |Pkg: 484 FBGA | Verilog
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2. Update the eNVM Memory Content window, as shown in Figure 24.
Figure 24 »+ eNVM Memory Content Window

M
W] eNVM Update Tool =
— ——
Available Client types User Clients in eNVM
Data Storage
Serialization Client Type Client Name DepthxiWidth Start Address(Hex) Page Start Page End Tnitialization O
1 |@ Datestorage Main_App 4592 x 8 0 0 35 /A
2 | @ DataStorage look 4x8 20000 1024 1024 N/A
Add to System...
Usage Statistics
Available Pages:4032
f Used Pages: 37
Free Pages: 3995 |
f
|
N 4 1 3
i
| You can disable programming for a dient by editing the dient and selecting the No Content’ option.
N The content will be preserved and programming of this dient can be re-enabled by selecting the preserved content.
i
| B UsedSpace
|
Lo J[ e ]
=

3. Browse through the updated . hex file generated in the Release Mode from the SoftConsole
application project, refer to Figure 25. Click Ok.

Figure 25 + Updated Hex File in Release Folder

%‘ INQC:\eNVM_DataClient\SoftConsole\eNVM DataClient MSS CM3\projects\eMVM_DataClient MSS CM3 app)\Release| - "'f_
Organize * Include in library + Share with - Burn Mew folder
Y Favorites Name : Date modified Type Size
Bl Desktop | eNVM_DataClient_MS5_CM3_app 30-09-201511:38 File 128 KB
& Downloads | eNVM_DataClient_MS5_CM3_app.hex 30-09-201511:38 HEX File 13 KB
2] Recent Places | eNVM_DataClient_MS5_CM3_app.lst 30-09-201511:38 LST File 106 KB
| eNVM_DataClient_MS5_CM3_app.map 30-09-201511:38 MAP File 54 KB
4 Libraries E | eNVM_DataClient_MS5_CM3_app.srec 30-09-201511:38 SREC File 13 KB
@ Documents _| main.d 30-09-201511:38 D File 1KB
o Music | main.o 30-09-201511:38 O File 3KB
[&5] Pictures | makefile 30-09-201511:38 File 3KB
=) Subversion =] memory-map 30-09-201511:38 XML Document 1KB
BF videos || objectsmk 30-09-201511:38 MK File 1KB
|| sources.mk 30-09-201511:38 MK File 2KB
18 Computer || subdirmk 30-09-201511:38 MK File 3KB
&L Local Disk (C:)
l 12 items.

4. Click Generate Bitstream to complete the remaining steps to generate the fdb file (synthesis,
place-and-route).
5. Click Run PROGRAM Action to program the SmartFusion2 Security Evaluation Kit.
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29 Running the Design on SmartFusion2 Security
Evaluation Kit

The following steps describe how to run the design:

1. Connect the FlashPro4 programmer to the J5 connector of SmartFusion2 Security Evaluation Kit.
2. Connect the host PC to the J18 connector provided on the SmartFusion2 Security Evaluation Kit
using the USB min-B cable. Ensure that the USB to UART bridge drivers are automatically detected
(can be verified in the Device Manager as shown in Figure 26).
Note: Copy the COM port number for serial port configuration. Ensure that the COM port location is specified
as on USB Serial Converter D, as shown in Figure 26.

Figure 26 » Device Manager Window

rﬁ Device Manager l = | [E] &]
File Action View Help i
=2 | = E HE | E %S

4= wibd-edarap
> 1M Computer - USE Serial Port (COME)
-y Disk drives =
=
- B Display adapters
b - DVD/CD-ROM drives
+ W5 Human Interface Devices

USB Serial Port (COMS) Properties ==

General | Port Settings I Driver I Detail5|

Device type: Ports (COM & LPT)
Manufacturer: FTDI

b g IDE ATASATAPI controllers Location: on USE Serial Converter D

- ¥ Jungo

b &3 Keyboards Device status

:» B Mice and other pointing devices This device is working propery. -
> Bl Monitors

b ¥ Metwork adapters

473" Ports (COM & LPT)

" ? Communications Port (COM1)
--‘? USE Serial Port (COM3)

--‘? USE Serial Port (COM4)

--‘? USE Serial Port (COMS)

i

1 ? USE Serial Port (

Update Driver Software...
>-D Processors
b -%| Sound, video and g Disable
b M System devices Uninstall
b a Universal Serial Bus OK ] [ Cancel

Scan for hardware changes|

Opens property sheet fort Properties

3. If USB to UART bridge drivers are not installed, download and install the drivers from
www.microsemi.com/soc/documents/CDM_2.08.24 _WHQL_ Certified.zip.

4. Connect the power supply to the J6 connector and switch ON the power supply switch, SW7.

5. Start the HyperTerminal program with a baud rate of 57600, 8 data bits, 1 stop bit, no parity, and no
flow control. If the PC does not have HyperTerminal program, use any free serial terminal emulation
program such as PuUTTY or TeraTerm. For more information about configuring the HyperTerminal,
TeraTerm, and PuTTY, refer to Configuring Serial Terminal Emulation Programs Tutorial.

6. Program the SmartFusion2 Security Evaluation kit board with the job file provided as part of the
design files using FlashPro Express software, refer to Appendix 1: Programming the Device Using
FlashPro Express, page 37.

Note: This step is required if *. job file in the design folders is used. In Libero design, Run PROGRAM Action
programs the * . job file to the Board.

7. After successful programming, press SW6 switch to reset the board.

8. The serial terminal program displays the user options, as shown in Figure 27, page 20.
»  Select option 1 to get Factorial of number 2.
»  Select option 2 to get Factorial of number 3.
+  Select option 3 to get Factorial of number 4.
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Figure 27 » Selecting Factorial of a Number - User Options

#  Serial_Output - HyperTerminal — - o B
File Edit Yiew Call Iransfer Help -
D& E DH =

HiH Welcome to SmartFusion? HHHH
Please Select the Following option
1.Factorial of 2
2.Factorial of 3

il |3.Factorial of &

The application image fetches the Factorial Value from the Look up table (Non-executable image) and
displays it, as shown in Figure 28.

Figure 28 » Displaying Factorial Value Based on User Option

# ' Serial_Output - HyperTerminal - -— = | (B e S,

File Edit View Call Transfer Help

HiH Welcome to SmartFusion? #itH#
Please Select the Following option
1.Factorial of 2

2.Factorial of 3

J3.Factorial of 4

Factorial of 2:

Please Select the Following option
1.Factorial of 2

2.Factorial of 3

J3.Factorial of 4

Factorial of 3:

Please Select the Following option
1.Factorial of 2

2.Factorial of 3

J3.Factorial of 4

gzctorial of &:

Please Select the Following option
1.Factorial of 2
2.Factorial of 3
3.Factorial of 4

Connected 0:00:11 Auto detect 57600 8-N-1 NUM

2.10

Building Multiple Executable Images in Release Mode

The design files are available to download from the Microsemi website. For design files, refer to:
Prerequisites, page 3.

This design contains the eNVM data storage clients for Multiple Hex images. It runs the images in eNVM

and eSRAM, and the LEDs blink in various patterns. This design demonstrates how to build multiple
images in the release mode and store them in eNVM.
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The following steps describe how to build multiple application executable image in the release mode:

1. Open the standalone SoftConsole IDE.

Figure 29 « SoftConsole IDE
SC C/C++ - Welcome to Microsemi SoftConsole IDE v34 - Microsemi SoftConsole IDEv3.4 s

File Edit Source Refactor Navigate Search Project Run Window Help

Lol )

=i 9 @O E G A B  H-0 A S B -eerD- & @)
5 Project Explorer 23 = 0)([E) Welcome &3 =05 outi % Mak | = 8
= % 7|/ Microsemi SoftConsole IDE v3.4 An outline is ot available

SoftConsole is  free software development environment
enabling the rapid production of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SoftConsole:
lets you write software that is immediately compiled into a usable binary.

5 StartaProject
To beginyour work,click File > New > C Project
Giveyour project» name, and selct  toolchaln f you ae going to
be compilingfor a target other tha the default choice of the Microse Cortx-M3.
Then cick Fnish.

‘Add an initialsource file with File > New > Source File

Add codeto it and click the Build Allicon.

® bisting Code
You can lso import an exiting source ree using
File > Import-
and click
‘General > File System

) Additional Information
* Release Notes

*Online documentation

20 Problems 52 Tasks | ] Console| I Propertes| =g
0items
Descrption B Resource Path Location Type

2. Right-click the Project Explorer window and choose Import, as shown in Figure 30.
Figure 30 »+ SoftConsole IDE - Import

56 C/C++ - Welkometo it SoiConsole D4 Wicrser SSRESHESETOE — e | — ~— T

File Edit Source Refactor Navigate Search Project Run Window Help

=he P s G- O E-6 K- B H-0-Q BF- @ Bl-F-ea-D- 5@
[ Project Explorer 23 = 8)(B Welcome 2 =05 outi % Mak | = 8
= % 7| Microsemi SoftConsole IDE v3.4 [An outline s not avalable
SoftConsole s afree software development environment
ensbiing the rapid producton of C and Ce- executablesfor processors
svailable for use in Microsemi devices. reating s project nside SoftConsole
letsyou pled nto s usable binary.
New ,
2 Import i
e  Starta Project
4 Egor To begin your work, cick File > New > C Project
N Give your project s name, and select s toolchsin f you are going to
&) Refresh 5 be compiling for a target other than the defautt choice of the Microsemi Cortex-M3.
Then click Fnish,
Add anintal source file with Fle > New > Source File
‘Add code to't,and clic the Build Allicon.
3 Existing Code
Vou can slso import an exsting source tree using
File > Import...
and click
‘General > Fle System
%) Additional Information
* Release Notes
* Online documentation
(2L Problems 57 Tesks| E Console| I Propertes| v=8
0items
Description - Resource Path Location  Type
0° Oitemsselected
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3. Select General > Existing Projects into Workspace, as shown in Figure 31.
Figure 31 « SoftConsole IDE - General

SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsemi SoftConsole IDE v34

—~ —— ~— l= = |
Fie Edt Souce Refactor Navigste Search Project Run Window Help
=he P s G- O E-6 K- B H-0-Q BF- @ Bl-F-ea-D- 5@
25 Project Explorer 23 = 8)(B Welcome 2 =05 outi % Mak | = 8
= % 7| Microsemi SoftConsole IDE v3.4 [An outline s not avalable
SoftConsole s afree software development environment
ensbiing the rapid producton of C and Ce- executablesfor processors
svailable for use in Microsemi devices. reating s project nside SoftConsole
letsyou write software that i immeditely compiled into a usable bina
v b come! st impor e =)
- Select
(5 Start a Project i
et otk clck File  New > CProject Creste new projects from an archive ile or directory. 121}
Give your project s name, and select s toolchsin f you are going to
be compiling for s target other than the defaut choice of the Microsemi
Then click Fnish, Selectan import source:
‘Add an initial source file with File > New > Source File type filter text
2 & Genenl
Add code to it, and click the Build All icon. = @, Archive File
[ Bisting Projects into Workspace]
o (2, File System
9 dting Code 1 Preferences
0u can slzo import an exsting source tre using
Fie s Tmport.” 5@ C/Chr
and click » & Qs
‘General > Fle System » & Run/Debug
b & Team
%) Additional Information
* Release Notes
* Online documentation
@ PR s =
(2L Problems 57 Tesks| E Console| I Propertes| v=8
0items
Description - Resource Path Location  Type
50 Oitems selected
Figure 32 » SoftConsole IDE - Browse
SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsem SoftConsole IDE v3.4 — — — l= = |
Fie £t Souce Refactor Navigste Search Project Run Window Help
[nd ¥ A @ErE&EvEvE~ LrEy H-0-Q~- @™ 5~ & bl G5l v - - @f
25 Project Explorer 23 = 8)(B Welcome 2 =05 outi % Mak | = 8
= % 7| Microsemi SoftConsole IDE v3.4 [An outline s not avalable
SoftConsole s afree software development environment
ensbiing the rapid producton of C and Ce- executablesfor processors
svailable for use in Microsemi devices. reating s project nside SoftConsole
letsyou write software that i immeditely compiled into a usable bina
v b come! st impor e =)
- Import Projects
 Starta Project
et otk clck File  New > CProject Select s diectory to search or eisting Eclipse projects
Give your project a name, and select a toolchain if you are going to <
be compiling for s target other than the defaut choice of the Microsemi
Then click Finish. @ Select root directory: Browse...
Add anintal source file with Fle > New > Source File P -
Add codeto t,snd click the Build Alcon ra—
Select All
3 Existing Code
You can also import an existing source tree using Deselect All
File > Import...
and ik
‘General > Fle System
%) Additional Information
* Release Notes
* Online documentation [] Copy projects into workspace:
Working sets
[EJAdd project to working sets.
Warking sets Select.
® s ][ en
(2L Problems 57 Tesks| E Console| I Propertes| v=8
0items
Description - Resource Path Location  Type
50 Oitems selected
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Figure 33 + SoftConsole IDE - Browsing for App Folder

SC/C/C++ - Microsemi SORCOREAR IDE VA

SET= )
File Edt Source Refactor Navigate Search Project Run Window Help
=hd 9 A QB F G R-B H-0-Q- ™S [E P P —— R —
& projetEporr 25 55 ~=0

= 0] (82 outi 2\ © Mak | = O

‘An outline i not available.

¢ Import Gl

Import Projects

-

© Seec oot ety

) >
Browse For Flder ==
P

Select root directory of the projects to import

471 eNVM Mutiple Images B
DDR Configuration Files
4 )l LiberoProject
4 ). Remapping_Approte
> i component

constraint

aeigner
[ pablems [ 2 Tsks [ Comole 53 5 Properie] || (9 Copyprojectinto worand| e SRR
No consoles todislya tistme Woring e M

7] Add project to working sq)| simulation

Woring et amangen

4 1. SoftConsole
4| Remapping_Appnote_Mss_CM3
[ projects

metadata
©) [ <o > i eNVM._to_SRAM imagel
> i eNVM _to_SRAM image2
> i eNVM._to_SRAM image3
NVM _to_SRAM imaged
Remapping Appnote MSS_CM3_app B

4. Ensure that Copy projects into workspace check box is checked, as shown in Figure 34. Click
Finish.

Figure 34 + SoftConsole IDE - Creating Work Space in App Folder

-
SC Import

Import Projects

Select a directory to search for existing Eclipse projects.

@) Select root directory:  CheNVM_Multiple_Images\LiberoProject\Rem: Browse...

Ny

() Select archive file: Browse...

Projects:

eMVM_to_SRAM_imagel (C:heMNVM_Multiple_ImagesiLiberoProjec Select All
eMVM_to_SRAM_image2 (C:heMNVM_Multiple_ImagesiLiberoProjec
eNVM_to_SRAM_image3 (CheMNVM_Multiple_Images'LiberoProje
eMVM_to_SRAM_imaged (CheMNVM_Multiple_ImagesiLiberoProjec
Remapping_Appnote_MS5_CM3_app (C:heNVM_Multiple_Images'
Remapping_Appnote_MS5_CM3_hw_platform (C:heMVM_Multiple
sample_image_eMVM_128KB (C:heNVM_Multiple_Images\LiberoP)

4 | i |

Copy projects into workspace
Working sets
[] Add project to working sets

Working sets: Select...

@ ned> | [ Finish ][ Cancel

Microsemi Proprietary AC426 Revision 6.0 23



Implementing Production Release Mode Programming for SmartFusion2

The SoftConsole perspective is shown in Figure 35.

Figure 35 + SoftConsole Workspace

SC C/C++ - Microsemi SoftConsole IDEv34

— —— ——
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| (T

File Edit Source Refactor Navigate Search Project Run Window Help

=4 |& ' 9is @-&8-E-6-: ]

MASE MU A SET- R AN H-F-earo-

B (@) 1

() Project Explorer &% BEg =0

> &5 eNVM_to_SRAM imagel
b & eNVM_to_SRAM image2

5 & eNVMto_SRAM image3

» & eNVMto_SRAM imaged

& Remapping_ Appnote_MSS_CM3_spp

M. h,_platform

= 0] (82 outi 2\ © Mak | = O

‘An outline i not available.

[ Problems | % Tasks [ E] Console 52 . Propertes|

C-Build [sample_image_eNVM_128KB]

o 1 sample image_eNVM_128KB.

5. Right-click both project names in the Project Explorer view and select Build Configurations > Set
Active > Release, as shown in Figure 36.

Figure 36

Building Configuration

SC C/C++ - Remapping_Appnote. MSS_CM3._app/

SOt v

e ™)

File Edit Source Refactor Navigate Search Project Run Window Help

NEHGIB 9L @8- E-6 K-8 $ -0 Q- S-S

Hrfloaray

5 % Debug

[ Project Explorer 23 B% "~ = 0|(Q mainc 2 =0z oui X @mak | = O
I#include Mm2swc.nt B EA TR N
Z#inclade "azivers/mss_sart/mss_sart.n 5 masonh
L 2 drivers/mss_uart/mss_ui
R 4 remap_user_code_eSRAI
E
=T 1d remap_user_code_eSRAM 0 (void) ; o
=1 Copy ctrsC id remap_user code eSRAM 1(void); #
o o 54 remap_user_code oV 128KB (void) ; #
R Delete Delete B ¥
Move, 1 #  ESRAMO_REMAP BASE
Rename P 2 #  ESRAMI_REMAP_BASE ,
3 # ENVM_DEMO_IMAGE.S
2 mport # IAGE.S
2 | [Eon 16#define ESRAMO_REMAP BASE_ADDR 0x20000000 * 1AGE
#define ESRAMI REMAP BASE_ADDR 0x20008000 ¥ 1AGE
Build Project o copy.image_to_ram(int)
I lefine ENVM_DEMO_IMAGE STORED 0 0x60004000 o Une oo o ]
. lefine ENV DEMO IMAGE STORED 1 0x60008000 o
Gl ® lefine ENVM_DEMO_IMAGE_STORED_2 0x60012000 o remap.user code_eNVM
Close Project lefine ENVM_DEMO_IMAGE_STORED_3 0x60016000 p-user
Close Unreated Projects
24void copy_image_to_ram(int type)
Exclude from build
Build Configurstions » ,
Make Targets » Build »| V| 2Release reszehddz;
Indec »|  Delete resource g,
Convert To Mansge. i
Run As ST 7T - M D « i D
Debug As > | | provems 52~ @ 7o & Cosole] T properie] =5
Profle As v | loeme
Team 4 Description - Resource Path Location  Type
Compare With ,
Restore from Local History.
0° G5 7itemsselected
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6. Go to Project > Build All and build the project, as shown in Figure 37.
.hex file is generated in the Release folder created in the project folder.

Figure 37 » Build All
5 C/C++ - NV _DataCHen M W appimain Wiereser SoComeoR BOES A — oo O )

Fie Edt Source Refsctor Navigste Search [Project] Run Window Help

HrHEIB P s g OpnPei cQr i@ A e sET)

[ BrojectExplorerii Close Project = O[3 outi 2 Mak | = B
culeg 3 AR o k7

& Buid Al

1 1125 eNVM._DataClient MSS_CM_opp| 5]

{5 eNVM _DataClient MSS_CN._ hw._platform| Build Configurati RO U m2soh
Build Project U drivers/mss uart/mss_u
Build Working Set » # ENVM_DEMO IMAGE S’
Clean. o printnumber(int) s int

©  UART Polled Rx(mss_ua
Build Automatically F omponents Poled fo(m.
UART_init( &g mss_uarcl,MSS_UART_S7600_BAUD,MSS_UART_DATA_§ BITS | MSS_UART_NO_PARITY | MSS_UART_ONE_STOP_BIT ): ©  main(:int

Meake Target » [0ART polled tx (sq_mss_uarci, (uints_t *)"#### Welcome to SmartFusion2 $F##\n\r",sizeof ("###} Welcome o SmartFusion2 ##H\nm\z")):

Properties e (1)

MSS_UART_polled tx (£g_mss_uarti, (sints_t =)"Please Select the Following option\m\r",sizeof ("Please Select the Following option\n\z"));
):

1SS _UART poLed_ox (69 _mas_uarcl, (uince s ~

MSS_UART_polled tx (eg_mss_uartl, (uinte_t *;

Factorial of 4\n\r",sizeof ("3.Factorial of 4\n\z"));

while( (:(VART_Polled Rx ( &g_mss_uartl, rx buff, 1))) )

data = *(unsigned int *)ENVM_DEMO_IMAGE_STORED_ADDR;

byte(3] = data & OXFF:

[ Problens [ Toss| & Console 55 Propenis]
C uild [NVMLDsaChent S5 M o

%% Clean-only build of configuration Release for project eNVM DataClient MSS_CH3_app *++*

make clean
m -rf ./eNVM DataClient MSS_CM3_app.map
m -rf memory-map.xml ./main.o ./main.d eNVM DataClient MSS_CM3_app.srec eNVM DataClient MSS_CM3_app.hex eNVM DacaClient MSS_CM3 app.lst eNVM DataClient MSS_CM3_app
eNVM_DataClient MSS_CM3_app

o 5 2 items selected
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Loading Multiple Executable Images into eNVM

Multiple SoftConsole application projects generate multiple executable images. These executable
images are stored in eNVM.

The following steps describe how to load the generated application executable images into eNVM of the
SmartFusion2 device using the System Builder eNVM Configurator:

1. Open the Libero SoC hardware project Remapping_Appnote_top tab.

Figure 38 « Remapping_Appnote_top Tab

@ Libero - CAeNVM_Multiple Images\Li

25

e oo R —— |

Project File Edit View Design Tools SmartDesign Help

N 2NoBE &
sign Flow

i 8 x|

Reports 8 %[ Startpage & X | ) Remapping_Appnot=_top™ & X ‘

Remapping_Appnote_top

B O

@emar M R o° 5 QQKAE ANDO

&
Tool e
¥ 4 » CreateDesign
& System Builder
"4 & Configure MSS.
Create SmartDesign
Create HDL
B8 Create SmartDesign Testbench
Create HDL Testbench
4 b Verify Pre-Synthesized Design
B simulate
Create Constraints
4 =E /O Constraints
@ constraint\io\Remapping_Appnote_top.io.pdc
4 () Timing Constraints
@ synthesis\Remapping_Appnote top_sde.sdc
B Floorplan Constraints
Implement Design
A S Synthesize
¥ Verify Post Synthesis Implementation
B simulate
A B3 Compile

+{] Confiqure Flash*Freeze s

Design Flow | Design Hierarchy | _Stimulus Herarchy | Catalog | Fies |

Remapping_Appnote_0

4BDFAB_RESETN POWER_ON_RESET_N

[DEVRST NB—— @ DEVRST_N DOR_READY
MSS_READY

| MDDR_PADSE

INT_PINSEl

EHMDDR PADS

GRO FABRIC
EHMWUART 1_PADS

og

=]Mesoages | 8 Erors iy, Wamings i Info

"®¥Info: 'Remapping Appnote M35' was successfully generated.
generated.

©1nro: "Remapping Appnote’ was successfully generated.

@10t0: Systen Builder successfully generated 'Remapping Appnote’. Qpen Svstem Builder summary for details

@1nr0: "Remapping Appnote MSS' manifest file 'Ci/eNVM Multiple_Images/LiberoProject/Remapping_AppRote/carponent/work/Remapping Appnote MSS/Remapping Appnove MSS_manifest.cwt' was successfully

©1nr0: "Remapping Appnote’ manifest file 'C:/eNVM Multiple Tmages/LiberoProject/Remapping APpnote/component/work/Remapping Appnote/Remapping Appnote manifest.Txt' was successfully generated.

Log | Message

[Fam: SmartFusion2 [Die: M25090T [Pkg: 484 FBGA [Verilog

2. Double-click Remapping_Appnote_0 and go to System Builder - Memories page to add the
eNVM Data Storage client as shown in Figure 38, page 26 and Figure 39, page 27.

3. Select Data Storage under the Available Client types and click Add to System..., refer to
Figure 39, page 27. This opens the Add to Data Storage Client window, as shown in Figure 40,

page 27.
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Figure 39 + System Builder - Memories Page
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= = — = = N
(@) System Builder - Memories B
> Device Features Memories > » Peripherals » } Clocks Microcontroller SECDED Security 2 Interrupts > 2 Memory Map »
Configure your external and embedded memories
MDDR \/ ENVM
Available Client types User Clients in eNVM
Data Storage
Serialization Client Type Client Name I DepthxWidth Start Address(Hex) I Page Start Page End I Initialization Order Lock Start £
Add to System...
Usage Statistics
Available Pages: 2032
UsedPages: 0
Free Pages: 2032
< m ] v
!

Figure 40 » Add to Data Storage Client Window

| Add Data Storage Client

Client name:
elVM
Content:

@ Memory file:
Format:
[ Use absolute addressing
() Content filed with 0s
() No Content (Client is a placeholder)
Start address: ox 0 =
bits
Mumber of Words: 1

|:| Use as ROM o

Size of word:

[ Use Content for Simulation

o

(decimal)

.
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4. Enter a data storage client name in the Add to Data Storage Client window.

Figure 41 + Add to Data Storage Client Window

| Add Data Storage Client

ER=x=)

Clientname:  eNVM_MainApp_HexFiled

elVM
Content:

@ Memory file:
Format:
[ Use absolute addressing o
() Content filed with 0s
() No Content (Client is a placeholder)
Start address: ox 0 =
bits
Mumber of Words: 1

|:| Use as ROM o

Size of word:

[ Use Content for Simulation

| O )

(decimal)

J

Cancel ]

— e ey ——————

B

5. Browse for the . hex file generated after compiling the SoftConsole project in the Release Modes,
refer to Figure 43, page 29. The generated executable image is in the Release folder under
SoftConsole project workspace, refer to Figure 42.

Figure 42 » Executable Image in Release Folder

(€IS

|| t\Remapping_Appnote\SoftConsole\Remapping_Appnote MSS_CM3\projects\Remapping_Appnote MSS_CM3_app\Release ~ | +4

Search Release

Organize » Include in library = Share with + Burn New folder

Y Favorites Name Date modified
B Desktop | main.d 30-09-201512:23
4 Downloads | main.o 30-09-201512:23
| Recent Places || makefile 30-09-201512:23

=] memory-map 30-09-201512:23

3 Libraries ] objects.mk 30-09-201512:23
[5 Documents | Remapping_Appnote_Ms5_CM3_app 30-09-201512:23
&) Music | Remapping_Appnote MS5_CM3_spphex  30-09-2015 12:23
&) Pictures | Remapping_Appnote MS5_CM3_applst  30-09-2015 12:23
5i] Subversion | Remapping_Appnote_MS5_CM3_spp.map  30-09-2015 12:23
B Videos | Remapping_Appnote_MS5_CM3_spp.srec  30-09-2015 12:23

30-09-201512:23
30-09-201512:23

|| sources.mk
18 Computer
&L Local Disk (C:)

s New Volume (D:)

|| subdir.mk

cj MNetwork

' 12 items

Type

D File

O File
File
XML Document
MK File
File

HEX File
LST File
MAP File
SREC File
MK File
MK File

2KB
4KB
3KB
1KB
1KB
128 KB
15KB
139KB
61 KB
15KB
2KB
3KB

Microsemi Proprietary AC426 Revision 6.0

28



Implementing Production Release Mode Programming for SmartFusion2

Figure 43 + Add Data Storage Client Window

f -
(™ Add Data Storage Client
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2 ] |

Client name:  eNVM_MainApp_HexFiled

eNVM
Content:

@ Memory file:

Format: | Intel-Hex A

Use absolute addressing

pp/Release Remapping_Appnote_MSS5_CM.

Content filled with 0s
Mo Content (Client is a placeholder)

Start address: 0x 0 =

Size of word: 8 | bits

Mumber of Words: 5040 (decimal)
Use as ROM o

Use Content for Simulation

Relp

3_app.hex

[

Ok ] | Cancel |

6. Click Ok in the Add Data Storage Client window.

7.
page 30.

Add the remaining Hex Files with their corresponding start addresses, as shown in Figure 45,

Table 2 lists the SoftConsole application projects in the Release mode, their . hex files, and their
mapping to the eNVM Client Name.

Table 2 » SoftConsole Application Projects and their Mapping to eNVM Client
Start

ENVM Client Name SoftConsole Release Mode Path Hex File Name Address
eNVM_MainApp_HexFileO Remapping_Appnote_ MSS_CM3_app\ Remapping_Appnote_ MSS_CM3 0x0

Release _app.hex
eNVM_to_SRAM_HexFile1 eNVM_to_SRAM_image1\Release eNVM_to_SRAM_image1.hex 0x4000
eNVM_to_SRAM_HexFile2 eNVM_to_SRAM_image2\Release eNVM_to_SRAM_image2.hex 0x8000
eNVM_to_SRAM_HexFile3 eNVM_to_SRAM_image3\Release eNVM_to_SRAM_image3.hex 0x12000
eNVM_to_SRAM_HexFile4 eNVM_to_SRAM_image4\Release eNVM_to_SRAM_image4.hex 0x12000

eNVM_128KB_HexFile5

sample_image_eNVM_128KB\Release sample_image_eNVM_128KB.he 0x20000

X

Note: Start address is the address in which the executable image is stored in eNVM. Provide the required
memory size based on the total size of the executable image. Otherwise, the images overlap and display
error as shown in Figure 44, page 30.
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Figure 44 » Error due to Image Overlap
O Syetem Eurier TMemone — - — — el )

> Device Features Memories > » Peripherals »  Clocks Microcontroller SECDED Security > 2 Interrupts » > Memory Map »

Configure your external and embedded memories

MDDR \/” 7% ENVM |
Available Client types User Clients in eNVM @
Data Storage
Serialization | Client Type Client Name DepthxWidth Start Address(Hex) Page Start Page End Initialization Order
1 |o Data Storage eNVM_MainApp_HexFiled 5040% 8 0 0 39 N/A
2 |@ Data Storage|  eNVM_to_eSRAM_HexFile1 4576 x 8 2000 64 95 A
Add to System...
3 |@ DataStorage|  eNVM_to_eSRAM_HexFile2 4576 % 8 3000 9% 131 N/A
Usage Statistics 4 |0 Data Storage|  eNVM_to_eSRAM_HexFile3 4576 x 8 5000 160 195 A
Available Pages:4032 5 ‘
o — @) DataStorage|  eNVM_to_eSRAM_HexFie4 4576 % 8 7000 224 259 NjA

FreePages: 3310 5 i NVM_128KB_HexFile5 4784% 8

B Used Space

Figure 45 shows the correct memory locations chosen. It does not display any error.

Figure 45 » Hex Files with Correct Start Addresses

= — > e —
(® System Builder - Memories B
> Device Features » 7 Memories > > Peripherals » 7 Clocks > > Microcontroller > > SECDED » > Security » » Interrupts » ) Memory Map »
Configure your external and embedded memories
MDDR "/ ENVM '\
= User Clients in eNVM
Data Storage
Serialization | Client Type Client Name Depthaitidth Start Address(Hex) Page Start Page End Initialization Order
f 1 |0 Data Storage eNVM_MainApp_HexFiled 5040 x 8 0 0 35 N/A
2 |o DataStorage|  eNVM_to_eSRAM_HexFile1 4576 % 8 4000 128 163 N/A
[ asdosien. | |0 DataStorage|  eNVM_to_eSRAM_HexFile2 45768 3000 256 291 N/A
Usage Statistics + |0 DataStorage|  eNVM_to_eSRAM_HexFile3 45768 12000 576 611 NjA
Avaiizble Pages: 4032 5 |0 DataStorage|  eNVM_to_eSRAM_HexFiled 4576 % 8 16000 704 739 NJA
Used Pages: 222
FreePages: 3810 & |0 Data Starage NVM_128KB_HexFiles 47848 20000 1024 1081 NjA
< {11} 3
B Used Space
Bl FreeSpace Optimize Edit Delete
|

8. Inthe System Builder - Memories page, keep the other settings to default and click Next, refer to
Figure 45.

9. Save Remapping_Appnote_top and regenerate the Remapping_Appnote_0 component by
clicking Generate Component in SmartDesign.

10. Click Generate Bitstream to complete the remaining steps to generate fdb file (synthesis,
place-and-route) as shown in Figure 46, page 31.

11. Click Run PROGRAM Action to program the SmartFusion2 device to initialize the eNVM with the
memory file as shown in Figure 47, page 32.
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Figure 46 » Regenerating Remapping_Appnote_0 Component
j ing Appreote Remapping Approteprc* T

(D Libero - CAeNVM_Multiple Images\Li

& Microsemi

a AS\MicrocHip company

T Ml

Project File Edit View Design Tools SmartDesign Help

NS W a0

Design Flow B % | Repuis & x | ERemapping_approte_top & X | StartPage & X |
Remapping_Appnote_top =] D == ';‘lp D“;ED DD =u_>D ®\ e‘ ®\ @ A \ D
Tool s
+£] Generate Back Annotated Files
B simulate
& Verify Timing

&, Open SmartTime
[ Verify Power
4 b 10 Analyzer
& 10 Advisor
£ SSN Analyzer

4P FAB_RESET_N
DEVRST N DEVRST_N

M Programming Connectivity and Interface

& Configure Pregrammer

Device /O States During Programming

4} Configure Security and Programming Options
% Configure User Pregramming Data

I

Remapping_Appnote_0

FOWER_ON_RESET_N X
DDR_READY X

4 b Program and Debug Design MSS_READY B X
v +£] Generate FPGA Array Data | MDDR_PADSEH@- - ------- EHMDDR _PADS
3 Updste eNVM Memory Content INIT PINSE]
4} Configure Hardware INIT_DONE :X

FAB_CCC_PINSE
GFIO_FABRICH@- - -=--=== GFIO_FABRIC
MMUART_ 1_PADSEH@- - ----=--=- MMUART 1_FADS

[35 Configure Programming Recovery -
Configure Security

4 b Program Design
v % Generate Bitstream
' Run PROGRAM Action
4 b Debug Design

| Design Flow | Design Hierarchy | Catelog | Fies |

Log

€ Erors i, Warnings i Info

Software Version: 11.7.0.119

Generating Bitstream File...
Software Version: 11.7.0.119
Software Version: 11.7.0.119
Software Version: 11.7.0.119

Opened 'C:/eNVM Multiple Images/LiberoProject/Remapping Appnote/designer/Remapping_Appnote_top/Remapping Appnote_top fp/Remapping Appnote top.pro’

The "open_project' command succeeded.

PDB file 'C:\eNVM Multiple Tmages\LiberoProject\Remapping Appnote\designer\Remapping Appnote_top\57ale280-£386-4b34-b386-3b34£3863b34.pdb’ has been loaded successfully.

DESIGN : Remapping Appnote_top; CHECKSUM : FB21; PDB VERSION : 1.9
The 'load_programming data' command succeeded.

The 'set_programming file' command succeeded.

Project saved.

The "save_project' command succeeded.

Project closed.

The "close_project’ command succeeded.

The Execute Script command succeeded.

Generating Bitstream File Finished : Mon Mar 14 11:24:31 2016 (Elapsed time 00:00:56)

Log | Message
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Figure 47 » Programming SmartFusion2 Security Evaluation Kit

@ Libero - CeNVM_Multiple Images\Li

Project File Edit View Design Tools

_App _Appnots

SmartDesign  Help
SNl

Design Flow

8 X | Reports X | ERemapping Aponote top & X | StartPage & X |

EORE¢  Bemke H

o 7 [
1L <15 ]

Remapping_Approte_top v ErH

ANDO

Tool
+£] Generate Back Annotated Files
B simulate
&, Verify Timing
&, Open SmartTime
Iy Verify Power
4 b 10 Analyzer

Remapping_Appnote_0

&~ 10 Advisor

4 P FAB RESET N

POWER_ON_RESET NBX

& SSN Anal
4 b Program and Debug Design

DEVRST N P DEVRST_N

DDR_READY X
MSS_READY X

v | Generate FPGA Array Data

Update eNVM Memory Content

onfigure Hardware

B Programming Connectivity and Interface

& Configure Programmer

- MDDR_PADSE@- - ------- EIMDDR_PADS
INIT_PINSEI:
X

FAB_CCC_PINSE
GPIO_FABRICEH@- --=====- @EGPO _FABRIC
MVUART_1_PADSE@- - -====== EMMUART 1_PADS

;s

F Device /O States During Programming
4} Configure Security and Programming Options

+ Configure User Programming Data

s Libero
2 Configure Programming Recovery - L ———

} Configure Security
4 b Program Design il
% Generate Bitstream
0 > Run PROGRAM Action
4 ) Debug Design

Running PROGRAM Action. Please do not interrupt.

| DesignFiow | Design Herarchy | Catalog | Fies |

Log
Errors i, Warnings @) Info

Generating Bitstream File Finished : Mon Mar 14 11:24:31 2016 (Elapsed time 00:00:56)
O1ns0: rirmare project was successfully ewported to 'Ci\ellVY Multiple Images\LiberoProject\Remapping Appnote\firmware'.
O1n:0: sorcConsole workspace was successfully generated.

O

Cleaning tool 'Generate Memory Map'...
Deleting 'C:/ellVM Multiple Tmages/LiberoProject/Remapping Appnote/corponent/work/Remapping Appnote_top/Remapping Appnote top DataSheet.xml'
Info: Succe y generated Memory Map Summary file 'C:/eNVM Multiple Images/LiberoProject/Remapping Appnote/component/work/Remapping Appnote top/Remapping Appnote top DataSheet.xml'
Software Version: 11.7.0.119
Software Version: 11.7.0.119
Driver : 3.0.0 build 1
programer '92601' : FlashPro4
Rescanning for Programmers...

Bead more on how Libero Sof integrates with your software development environment.

programmer '92601' : FlashPro4
Rescanning for Programmers DONE.
2 A in...

pro

gz

Log | Message

212 Updating eNVM Memory Content

This option is available in Libero design flow to load the updated . hex files after compiling the
application code in SoftConsole. Without this option, every time the SoftConsole application is built,
System Builder eNVM Configurator is required to update the eNVM client with the new . hex file
generated, which may be time consuming.

If the new . hex file generated from the SoftConsole application project is larger than the previous .hex
file, Update eNVM Memory Content throws an error. Go back to the System Builder and manually
update the Hex file.
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The following steps describe how to use Update eNVM Memory Content option:
1. Choose Update eNVM Memory Content option from Libero design flow.

Figure 48 » Update eNVM Memory Content Option

—————TT T L T =Tty

(D Libero - CAeNVM_Muttiple Images\Lil i ing_Ap
Project File Edit View Design Tools SmartDesign Help
e )
D a0
Design Flow 8 | Repots &% | Starteage & X | ) Remapoing_Appnote_top & X ‘ s

@ =Er P B P,r QA E ANDO

Remapping_Appnote_top

Tool E
I Programming Connectivity and Interface
& Programmer Settings
[ Device 1/O States During Programming

Remapping_Appnote_0

4} Configure Security and Programming Options ;
) Configure User Programming Data 4 DFAB RESET N  POWER ON RESET NP X
B Configure Programming Recovery DEVRST_N DDR_READY X
@ Configure Security | MSS_READY X
B2 Update eNVIM Memory Content MDDR _PADSH@ —-------
INIT_PINSE

» Program Design

INIT_DONE :x
FAB_CCC_PINSE
GFIO_FABRICE@ -

MMUART_1_PADSE -

B2 Configure Bitstream
% Generate Bitstream
B% Run PROGRAM Action
4} Debug Design
{84, Identify Debug Design
€ SmartDebug Design
4} Handoff Design for Production
4 Export Bitstream
4 Export Programming Job <

|

I

i

EMDDR _PADS

HGHO_FABRIC
BEIMMUART_1_PADS

DesignFlow | Design Hierarchy | Stmulus Herarchy | Catalog | Fies |

Log

@ Erors i, Wamings @ Info

Chain Programming Finished: Mon Feb 09 14:04:28 2015 (Elapsed time 00:01:59)
c-c-o-oc-o-o

The 'run_selected actions' command succeeded.
The 'set ng file' command

Project saved.

The 'save_project' command succeeded.
Eroject closed.

The 'close_project' command succeeded.

The Execute Script command succeeded.

Log | Message

Fam: SmartFusion2 |Die: M25090T [Pkg: 484 FBGA |Verilog

2. Update eNVM Memory Content window, as shown in Figure 49.
Figure 49 » Update eNVM Memory Content Window

1
O I - ., .. . T [
e User Clients in eNVM
Data Storage
Serialization Client Type Client Name DepthxWidth Start Address{Hex) Page Start Page End In
1 |4 Datzstorage| eNVM_MainApp_HexFileo 040 % 8 0 0 3
2 | P DatzStorage| eNVM_to_eSRAM_HexFilel 5T x 8 4000 128 163
Add to System...
? | B DatsStorage| eNVM_to_eSRAM HexFile2 4576 x 8 3000 255 291
Usage Statisti
S30% Stanshes 4 | @ DatnStorage| eNVM_to_eSRAM_HexFile3 76 x8 12000 576 611
Available Pages: 4032
UsedPages: 222 5 | € Datzstorage| eNVM_to_eSRAM_HexFied 4576 % 8 16000 04 739
FreePages: 3810 S | @D DatzStorage|  eNVM_123KB_HesFles 4734x 8 20000 1024 1061
4| 1 F
You can disable programming for a dient by editing the dient and selecting the "No Content’ option.
The content will be preserved and programming of this dient can be re-enabled by selecting the preserved content.
B UsedSpace
B freesome
L
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3. Browse through the updated .hex file, refer to Figure 50. Click Ok.

Figure 50 - Browsing through Updated Hex File

@O" || t\Remapping_Appnote\SoftConsole\Remapping_Appnote_MSS5_CM3\projects\Remapping_Appnote_MSS_CM3_app\Release + | 44
3 e —— = ——— — =

Organize * Include in library Share with - Burn Mew folder =« 01 @
S Favorites Name ° Date modified Type Size

Bl Desktop | main.d 30-09-201512:23 D File 2KB
& Downloads | main.o 30-08-201512:23 O File 4 KB
£l Recent Places || makefile 30-09-201512:23 File 3KB
=] memory-map 30-09-201512:23 XML Decument 1KB
4 Libraries _| objects.mk 30-09-2015 12:23 MK File 1KB
[# Documents || Remapping_Appnate_MSS_CM3_spp 30-09-201512:23 File 128 KB
& Music || Remapping_Appnote_MS5_CM3_app.hex  30-09-201512:23 HEX File 15KB
[E=] Pictures _| Remnapping_Appnote MSS_CM3_app./st 30-09-201512:23 LST File 139 KB
=] Subversion __| Remapping_Appnote_MSS_CM3_app.map  30-09-201512:23 MAP File 61 KB
B videos || Remapping_Appnote_MSS_CM3_spp.srec  30-09-201512:23 SREC File 15 KB
|| sources.mk 30-09-201512:23 MK File 2KB
1M Computer || subdir.mk 30-09-201512:23 MK File 3KB

&, Local Disk (C3)

ca Mew Volume (D:)

"F Network

' 12 items

4. Update the . hex files for the remaining data storage clients.
5. Perform Run PROGRAM Action.

213 Running the Design on SmartFusion2 Security
Evaluation Kit

The following steps describe how to run the design:

6. Connect the host PC to the J18 connector provided on the SmartFusion2 Security Evaluation Kit
using the USB min-B cable. Ensure that the USB to UART bridge drivers are automatically detected
(can be verified in the Device Manager), as shown in Figure 51, page 35.
Note: Copy the COM port number for serial port configuration. Ensure that the COM port location is specified
as on USB Serial Converter D, as shown in Figure 51, page 35.
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Figure 51

Note:

Figure 52
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Device Manager Window

-

= Device Manager E@ﬁ]
File Action View Help USB Serial Port (COMS) Properties ==
e BIE HE " B8RS —— .
General | Port Settings I Driver I Detall5|
4= wibd-edarap
> 1M Computer - USE Serial Port (COME)
» =g Disk drives i

:, - Display adapters
b - DVD/CD-ROM drives
+ W5 Human Interface Devices

b g IDE ATASATAPI controllers Location: on USE Serial Converter D

- ¥ Jungo

b - Keyboards Device status

:» B Mice and other pointing devices This device is working propery. -
> Bl Monitors

b ¥ Metwork adapters
Y3 Ports (COM & LPT)

b D Processors
b - Sound, video and g Disable

b /M| System devices Uninstall
b a Universal Serial Bus o ] [ —

Device type: Ports (COM & LPT)
Manufacturer: FTDI

? Communications Port (COM1)
= USB Serial Port (COM3)
= USB Serial Port (COM4)
=" USB Serial Port (COMS)
= USB Serial Port (

Update Driver Software...

Scan for hardware changes|

Opens property sheet fort Properties

7.

8.
9.

10.

If USB to UART bridge drivers are not installed, download and install the drivers from:
www.microsemi.com/soc/documents/CDM_2.08.24 WHQL_ Certified.zip.

Connect the power supply to the J6 connector and switch ON the power supply switch, SW7.

Start the HyperTerminal program with a baud rate of 57600, 8 data bits, 1 stop bit, no parity, and no
flow control. If the PC does not have HyperTerminal program, use any free serial terminal emulation
program such as PuUTTY or TeraTerm. For more information about configuring the HyperTerminal,
TeraTerm, and PuTTY, refer to Configuring Serial Terminal Emulation Programs Tutorial.

Program the SmartFusion2 Security Evaluation kit board with the job file provided as part of the
design files using FlashPro Express software, refer to Appendix 1: Programming the Device Using
FlashPro Express, page 37.

This step is required if * . job file in the design folders is used. In Libero design, Run PROGRAM Action
programs the * . job file to the Board.

11.
12.

After successful programming, press SW6 switch to reset the board.
The serial terminal program displays the user options, as shown in Figure 52.

Running Hex File - User Options

13.

14.

(87 Serial Output - HyperTerminal [E=NET—)
Eile Edit View Call Jransfer Help
D& &3 DB o

#ielcome to SmartFusion? - Running HexFile@H
Select the below option

1. Run Hex Filel from eSRAM

2. Run Hex File? from eSRAM

3. Run Hex Filed from eSRAM

4. Run Hex Filek from eSRAM

9. Run Hex Filed from eNVH

Select option 1 as shown in Figure 53. The application image runs from eSRAM. E1, F4 LEDs blink
on the Board.

Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.

Microsemi Proprietary AC426 Revision 6.0 35


www.microsemi.com/soc/documents/CDM_2.08.24_WHQL_Certified.zip

http://www.microsemi.com/index.php?option=com_docman&task=doc_download&gid=130815

Implementing Production Release Mode Programming for SmartFusion2

Figure 53
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LEDs Blink Based on User Option

File Edit View Call Transfer Help

~u

=

2.14

Select
1. Run
2. Run
3. Run
4. Run
5. Run

Select
Run
Run
Run
Run
Run

LN~ oM =

#llelcome to SmartFusion? - Running HexFileO#

Running Hex Filel

LEDs Blinking

LEDs Blinking

LEDs Blinking

LEDs Blinking

LEDs Blinking

LEDs Blinking

LEDs Blinking

#llelcome to SmartFusion? - Running HexFileO#

the below option

Hex Filel from eSRAM
Hex File? from eSRAM
Hex File3 from eSRAM
Hex Filed from eSRAM
Hex Fileb from eNWM

the below option

Hex Filel from eSRAM
Hex File? from eSRAM
Hex File3 from eSRAM
Hex Filed from eSRAM
Hex Fileb from eNWM

Connected 0:01:14 Auto detect 57600 8-N-1 NUM

15.
16.

17.
18.

19.
20.

Select option 2. The application image runs from eSRAM. F3, G7 LEDs blink on the Board.
Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.

Select option 3. The application image runs from eSRAM. H7, J6 LEDs blink on the Board.
Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.

Select option 4. The application image runs from eSRAM. H6, H5 LEDs blink on the Board.
Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.

21. Select option5. The application image runs from eNVM. E1, F4, F3, G7, H7, J6, H6, H5 LEDs blink
on the Board.

22. Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.

Conclusion

This application note describes the step-by-step approach to build single/multiple SoftConsole
application executable images in production release mode, store the executable images into eNVM using
eNVM data storage client, and execute them on SmartFusion2 Security Evaluation Kit.
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3 Appendix 1: Programming the Device Using
FlashPro Express

This section describes how to program the SmartFusion2 device with the programming job file using
FlashPro Express.

The following steps describe how to program the FlashPro Express:

Switch ON the power supply switch SW7.

Launch the FlashPro Express software.

Click New Project.

In the New Project window, type the project name as:

*  SmartFusion2: SF2_MDDR_Demo

5. Click Browse and navigate to the location where you want to save the project.
6. Select Single device as the Programming mode.

7. Click OK.

The FlashPro new project is shown in Figure 54.

PON~

Figure 54 « FlashPro Express Job Project

E FlashPro Express

Project Edit View Programmer Help 53 FlashPro Express

= Edit View Programmer Help
Job Projects
| New Job Project from FlashPro Express Job  Ctrl+N - h
~ ;
New. .. 7+ Open Job Project Cul+O
QQQH X Close Job Project
il Savelob Project Ctrl+Shift+A
Recent Projects
or Set Log File »
Export Log File
Preferences...
Execute Script Ctrl+U
Export Script File...
Recent Projects »
Exit Ctrl+Q
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8. Enter the following in the New Job Project from FlashPro Express Job dialog box:

Programming job file: Click Browse, and navigate to the location where the . job file is located

and select the file. The default location is:

<download folder>\m2s ac426 df\Programming Job

* FlashPro Express job project name: Click Browse and navigate to the location where you want to
save the project.

Figure 55 « New Job Project from FlashPro Express Job

IProgramming job file: I

Browse...

FlashPro Express job project name:
i
IFIashPro Express job project location: I
] Browse...

Help OK | Cancel ]

5

9. Click OK. The required programming file is selected and ready to be programmed in the device.

10. The FlashPro Express window appears as shown in Figure 56. Confirm that a programmer number
appears in the Programmer field. If it does not, confirm the board connections and click
Refresh/Rescan Programmers.

Figure 56 « Programming the Device

Project Edit View Programmer Help
Refresh/Rescan Programmers
‘lﬂ M2GLO10TS %
Programmer
| < TDO DI
j @ ¥ jo3sPD | IDLE ' IDLE
[PROGRAM -

11. Click RUN. When the device is programmed successfully, a RUN PASSED status is displayed as
shown in Figure 57.
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Figure 57 » FlashPro Express—RUN PASSED

lPro__iect Edit Wiew Programmer Help

|
Refresh/Rescan Programmers |

@ mecLotots @
Programmer

e i josnn [NINUNPASSEONN  ASSEI

|

[PROGRAM |
s 1PROGRAMMERG)PASSED

Leg
[*)Messages @ Emors & Warnings @ Info

jprogrammer 'EZ20035FJLD' : dewvice 'M2GLO10TS5' : EXPORT DSN[128] = cllfd4aB65cd98cZbbab6icifedTi04eb ﬂ
programmer 'E2003SFJLD' : device 'M2GLO10TS'

jprogrammer 'EZ003SFJLD' : device "M2GL010TS' : Finished: Wed Sep 16 20:0%:58 2020 (Elapsed time

00:00:27)

programmer "E2003SFJLD' @ device "M2GLO10TS' : Executing action FROGRAM PASSED.

programmer 'E20035FJLD' @ Chain programming PASSED.

Chain Programming Finishsd: Wed Sep 16 20:08:58 2020 (Elapsed time 00:00:27) :‘

12. Close FlashPro Express or in the Project tab, click Exit.
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4 Appendix 2: Creating LookUpTable.Hex File

The LookUpTable.Hex file contains the pre-calculated factorial data and this is a non-executable
image.

The following steps describe how to create the LookUpTable. Hex file:

1. Open the notepad and enter the factorial of number 2, 3, 4 as 2, 6, 24 as shown in Figure 58.
Figure 58 » Entering Factorial Values in Notepad

| Untitled - Notepad [E=EER
[ File Edit Format View Help |

‘2624| ,‘

2. Save the notepad as LookUpTable.bin, as shown in Figure 59.
Figure 59 « Saving Notepad
Swve As [

'Q. J=| b v Computer » NewVolume (0:) » Microsemi b utilities » v |4y P
o

Organize = New folder - 7]

{ Favorites
Bl Desktop 57 binZhex
& Downloads BB binZhex

| Recent Places

4 Libraries
¢ Documents
o Music
= Pictures
B videos
& Computer
& Local Disk ()

s New Volume (0t)

File name:  LookUpTable.bin -

Seve as type: |All Files -

= Hide Faolders Encoding | ANSI - Save Cancel

3. The executable file, bin2hex.exe, converts the LookUpTable.bin, which is in binary format to
LookUpTable.Hex in Hex format. This executable file is available in the design files path provided
along with this application note. For design files, refer to: Prerequisites, page 3.

Figure 60 « Converting Binary File to Hex File

BN C\Windows\system32\cmd.exe l =NUCE X

soft | [U ion 6.1.76881
ppyright ) i rosoft Corporation. All rights reserved.

2hex.exe LookUpTahle.bin LookUpTable.Hex

: LookUpTahle.
LookUpTahle .He
ARBA : Beae
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4. The LookUpTable.Hex file is generated, as shown in Figure 61. This file is copied to SoftConsole
project folder of the eNVM Data client SoftConsole project.

Figure 61 + LookUpTable.Hex File

IS0\ Microsemilutiliti

Organize + L] Open = Bum New folder

W0 Favorites Name Date modified Type
B Desktop =7 binZhex
i Downloads B binhex 6
) Recent Places | LeckUpTablebin 62712
| LockUpTable.Hex 6/27/2014 4:51 PN

HEX File
4 Libraries

¥ Documents

o' Music

| Pictures

B videos

1% Computer
&, Local Disk (C)
@ Mew Volume (Dx)

€ Network

LookUpTable.Hex Date modified: 6/27/2014 4:51 PM Date created: 6/27/2014 4:51 PM

HEX File Size: 34 bytes
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